
Tutorials
Card Project Tutorial

LetÕs get started! One of the most versatile and fun projects in Printmaster Gold is the card project. 
But, donÕt let the name fool you--ItÕs not just for cards. In card projects, you can create invitations, 
programs, or menus.

To get your feet wet, letÕs start with a card that already has art, sentiments, and size chosen for you--
what we call a Ready-Made. Remember, no Ready-Made is set in stone. In PrintMaster Gold, you can 
make just about any change you want, from turning a Birthday Greeting into a Get Well card or a Get 
Well card to an invitation.

In this card tutorial, we will:
¥ Introduce the Hub Screen
¥ Introduce the Ready Made Gallery
¥ Select a Ready Made Birthday card
¥ Edit text
¥ Check spelling
¥ Move a picture
¥ Resize a picture
¥ Rotate a picture
¥ Add a new picture from the Art Gallery
¥ Add a new sentiment from the Sentiment Gallery
¥ View, save, print, and fold the card

Selecting a Ready-Made Card Project
After you launch PrintMaster Gold, youÕll land in what we call the Hub.

This is where it all starts. If you know exactly what you want and want to design your project yourself, 
you might start with Brand New. If you are a little unsure and wanted guidance every step of the way, 
you might choose With Help. 

For now, letÕs go with a Ready-Made. Here, weÕll take a look at some of the thousands of cards our 
vast team of artists have already created. Then, weÕll make a few changes to make it our own.

1. Click on Ready-Made. 
The Ready-Made button takes you to the Ready-Made Gallery:

HereÕs where you choose your project type, category, tone, style, and media. If you have an idea of 
what youÕre looking for (like ÒFatherÓ or ÒBirthdayÓ), you can type the word in the Keyword box 
and click on Find Now. PrintMaster Gold will search for all the projects that match your request.

2. In the Project window, select PrintMaster/Card.
3. In the Category window, select Birthday. Your Gallery menu will look like this:

Browsing the Cards



Several thumbnail selections will appear in the Gallery window to the right of the Gallery menu. To see 
more Card projects within the same category, scroll down the selection or click the View Size Window 
on the bottom of the Gallery window. 

Note: A larger view of the card is available by clicking on the View Size menu at the bottom of the 
Gallery window.

Note: You can also search for a project by using the Keyword search. Type in any word into the 
Keyword box and PrintMaster will find all the projects that match your request. Use the star (Ò*Ó) 
wildcard to find all versions of the word you are searching for. For example, ÒSport*Ó will find not 
only ÒSportÓ, but ÒSportsÓ and ÒSportsmenÓ.

4. Select the card you like by clicking on it once so it is highlighted, then click on the Select 
button at the bottom left of the Gallery menu. Or, after selecting the card, click the ENTER key or 
double-click the preview.

Personalizing your card
After selecting the card you want to work on, youÕll be taken to the Workspace. The Workspace is like 
a drafting board, with all the text, drawing, and positioning tools youÕll need to personalize and adjust 
your Ready-Made.

Editing Text
The card you picked might have had a fun headline, but youÕre sure you can write something even 
better. No problem. LetÕs make some adjustments to the text.

1. To edit the headline, click once on the text. Notice the insertion point blinks where you clicked 
between the letters. Also, notice six ÔhandlesÕ have appeared around the text box. You can use 
these handles to reshape your text box. Notice also that in the text menu above the card, the text 
status bar is updated: it tells you the font, the size, and the style of your headline.

2. Highlight the text you want to change by holding down the left mouse button and dragging 
across the letters. Type in the new text (for example, ÒDear Friend: DonÕt fight it. YouÕre 
ancientÓ).

Check the Spelling of your card
PrintMasterÕs spell checking feature will find misspelled words anywhere in your project.

1. Click the Check Spelling button on the Global toolbar. The Check Spelling window will 
appear. If it has found a misspelled or unfamiliar word, it will be highlighted in the top field of 
the window. If the Check Spelling feature does not find a misspelled or unfamiliar word, the 
window will not appear.

2. Notice the list of Suggestions. If one of those words is the correct spelling of the word 
highlighted, select it and click Change. If you do not want to change the spelling, click Ignore 
or Ignore all if there are other occurences of the word in the project.

Adjusting pictures
Perhaps you like the pictures on your Ready-Made card, but youÕd like to move them around a bit. No 
problem.

1. Click on a picture on your card. Be sure to click directly on an opaque section of the picture, 
and not on the background behind it. Once you click on it, you will notice again that handles 
appear on the edges of the picture boundary. ThatÕs how you know itÕs ÔactiveÕ.



2. When the cursor is now over the opaque section of the ÔactiveÕ picture, the cursor turns into a 
Ômove cursorÕ. It looks like cross-hairs. That means you can now move the picture by holding 
down the left mouse button and dragging the picture wherever you want. Note: You can also 
move the active picture, pixel by pixel, by using the arrow keys.

Hint: In general, itÕs more effective to keep people and other images from facing off the page. 
Instead, try facing them towards the sentiment or other elements. This helps keep the focus on 
the important components of the design.

3. To resize a picture, drag one of the handles located on the outside edge of the pictureÕs 
boundary box out to make it larger, or drag it in to make it smaller.

Hint: ItÕs usually not a good idea to resize bitmapped pictures. YouÕll see they get garbled 
and Ôstair-steppyÕ.Ó

4. To rotate the picture, make sure the picture is active (the handles around it are showing). 
YouÕll notice that when your cursor passes over one handle on its side, the cursor turns into a 
rotating arrow. This is the Ôrotate handleÕ. Now drag the rotate handle around the picture to 
the angle you desire.

Hint: the objects on your project are placed in layers. The first object is on the bottom, and 
each object placed above it, one by one. To view each object by layer, repeatedly hit the Tab 
key. Once the object your are interested in becomes active, you can work on it (adjust its size or 
color, for example) without changing its order in the stack.

Adding pictures
After making adjustments to your pictures, you may now want to add another picture to make it your 
own special creation. ItÕs easy. 

1. To add a picture to your card, click on the Add Picture button on the left menu bar. The Art 
Gallery will replace the Workspace:

2. Choose a Category, Tone, Style, and Media for your new picture. Or, if you want to search for 
a picture using Keywords, type a few words into the Keywords window and click OK. 
Note: use the star (Ò*Ó) wildcard to find all versions of the word you are searching for. For 
example, Òbrid*Ó would find not only ÒBirdÓ, but ÒBirdsÓ and ÒBird BathÓ.

3. Select the picture you want by clicking on it twice in the Gallery window. Or, click on it once 
so it is highlighted, then click Select on the menu bar.

4. The Art Gallery will disappear and your picture will appear in the middle of your card. You can 
now move it or adjust it using the techniques described above.

Hint: Enlarging the cover image to fill the front and back of your card, edge to edge, can be a 
great way to make your ÒcanvasÓ appear larger.

Adding Sentiments
Perhaps youÕve decided the quote on your card is OK, but not just right. ItÕs easy to change it with 
our Sentiments Gallery. There you can leaf through the thousands of sayings, quotes, and jokes created 
by our witty scribes.



1. To add a new sentiment to your card, first click on the existing text on your card and delete it. 
Then click on the Sentiment Gallery button on the left menu bar. The Sentiment Gallery will 
above the Workspace.

2. Choose a Category, subcategory, and Tone you are looking for, or search for a specific 
sentiment using Keywords.

3. Select the Sentiment you want by clicking Select.
4. You will be returned to the Workspace and your Sentiment will appear in the middle of your 

card. Note that some quotes include both a ÔfrontÕ quote that only appears on the front of 
cards, and an ÔinsideÕ quote that will appear on the inside of the card. You can move the text 
or adjust it using the techniques described above.
Tip: If the cover of your card is strong enough, you donÕt need to place any text on it. By 
placing the sentiment only inside the card, you increase its impact. Sometimes, less really is 
more.

Viewing work

Selecting a Panel: 
Cards are made up of four separate panels comprising the front, back, and inside surfaces of the card. 
Each panel can have its own background, text, and picture elements. You can select the Card panel you 
want to view by clicking on the View Face menu at the bottom of the Workspace.

Tip: Add some punch to your design by using contrasting emotions inside and out. A serious, 
business-related cover that gives way to a happy, carefree payoff inside generates surprise and 
can really brighten someoneÕs day.

Zooming in and Out

You can look closer at your card by clicking on the zoom button (magnifying glass with +-sign). Or, 
you can click and hold down on the View Size menu at the bottom of the Workspace and go to 100%, 
200% or any other percentage you want.

Note: You can also zoom in to your project in the Workspace by typing the plus (Ò+Ó) key and 
zoom out by typing the minus (Ò-Ó) key on the number pad of your keyboard.

Print Preview

You can view your project before printing by clicking the Print Preview button on the Global Toolbar. 
In the Print Preview menu, you can zoom in, zoom out, and print your project.

Save Card

Now, before we print, itÕs time to save your project.

1. Click the Save button located on the Global menu at the top of your screen, or hold down the 
File menu, and go to Save. PrintMaster Gold will prompt you for a unique file name. 



2. Type a name into the box provided. You may also attach a short description to your card project 
by typing it into the Description box.

3. To change the default drive and/or directory that your project will be saved to, click Change... 
and select the new destination.

4. Click OK or press ENTER to save your card project.

Save Picture Files in Project: This feature is particularly useful when using pictures that are selected 
from a floppy disk or CD, or when you expect to place your card on a disk and pass it to a friend. When 
Save Picture Files in Project is selected, PrintMaster Gold will not require you to insert the floppy 
disk or CD containing the picture(s) used the next time you or your friend opens your project.

Print Card

YouÕre almost done! As the last, and most rewarding step, letÕs print your project. 

1. First, make sure your printer is turned on and you have selected the correct paper size in Print 
Setup (under the File menu).

2. Click the Print button to display the Print dialog box. From this dialog you can also choose the 
number of printed copies, the print quality, and other features. See the chapter 8, Printing a 
Project, for more information.

2. Click Print to begin printing your project.

How To Fold A Card

Card projects come in all shapes and sizes: wide, tall, big, and small. Ultimately, the size of your card 
will depend on what sizes are supported by your printer, and the paper size you choose. Here are three 
ways you can fold your card (determined by the type of card youÕve chosen).

Quarter Fold
A quarter-fold card is made from regular 8 1/2 x 11 paper, folded into fourths. It prints on one side of 
the paper and may be either horizontal or vertical.

1. For either a vertical or horizontal card, fold the paper in half across the middle, with the printing 
on the outside.

2. Fold the paper in half again.
Single Fold
A single-fold card is folded once, in half. It may be either horizontal or vertical. For a nicer looking 
card, print the outside on heavier paper and the inside on lighter paper. Then fold them together, 
placing a bit of glue on the front inside face of the card to hold the lighter paper in place.

Z Fold
A Z-fold card prints on one side of the paper and folds into a brochure. It is always vertical.

1. Fold the front third of the card with the printing on the outside.
2. Fold the inside of the card by aligning the edge of the paper with the fold made in Step 1. You 

can now use a bit of glue to seal the front to the middle face.

Return to the Hub

Now that youÕve created and printed your first card, we can return to the Hub, where you can chose 
another Ready-Made card or try any of the hundreds of other projects waiting for you.



1. Click the Close button to exit the Workspace and return to the Hub. If you have not already 
saved your Card, you will be prompted to do so at this point.

Design Tip from the Pros

ÒThe receiver of a card usually expects to see the front text near the top of the card. TheyÕll read it 
quickly, then flip to the ÔzingerÕ quote inside. So, itÕs not a good idea to scatter text all over the front 
of a greeting card.... ItÕs also a good idea to have the text on the front of the card line up visually with 
the text on the inside the card. The eye tends to stay at the same place when the card is opened.Ó

   Lori Saulsen, greeting card designer

PrintMaster Gold User Tip

ÒI make my Mom a birthday card every year. Every year itÕs just a little different, but every one of 
them includes one thing: a rose. Every year, a rose turns up somewhere--behind the headline, behind a 
tea kettle graphic, or maybe even on the back--but itÕs there. ItÕs become a bit of a game for Mom to 
find it. But I know she loves roses, so I wouldnÕt ever send her a card without at least one.

   Martin Mulon, Oklahoma City, OK

Photo Project Tutorial

Ever wondered what you would look like as a cowboy or the President of the United States? Photo 
Projects are a fun way to create pictures of you or your friends in fun scenarios, scenes, and poses. All 
you need is a Photo Project and a picture of your friend. YouÕll be surprised at the effect!

NOTE: Photo projects are available only in PrintMaster Gold Deluxe and PrintMaster Gold 
Publishing Suite.

In this Photo Project tutorial, we will:
¥ Select a Ready Made Photo Project
¥ Import your picture file from disk
¥ Acquire an image using PrintMasterÕs TWAIN support
¥ Place your image behind the Fun Photo template
¥ Resize an image
¥ Crop an image
¥ Adjust an image in PhotoEnhancer
¥ Reduce Red Eye in your scanned photo
¥ Save your Photo Project
¥ Save picture files in your project
¥ Print your Photo Project

Select a Ready Made Photo Project
1. From the Hub screen, click Ready Made. If you are in the Workspace, click the Ready Made 

button on the Global button bar. You will be taken to the Ready Made Gallery.



2. In the Ready Made Gallery, select PrintMaster/Photo under Project Type. PrintMaster Gold 
offers several different categories of Photo projects from which you may choose. If you would 
like to narrow your search, choose a Category, Tone, and Style.

3. Find the photo project you like, select it, then click Select (or, double-click on your selection). 
Your selection will then be placed in the Workspace.

Import your picture file from disk
The Photo project is comprised of Fun Photo, text, and graphic elements. The photo has been altered to 
allow you to place a picture of you or your friendÕs face behind it, creating the illusion that the face is 
attached to the body in the picture.

To add a picture you have on disk to your photo project:
1. Open the Art Gallery by clicking on the Add a Picture button on the Add menu.
2. Once you are in the Art Gallery, click on Open from Disk under the File menu. You will then 

see a dialogue box. If your file is not displayed in the window, scroll down to the appropriate 
path.

3. Select the file you want to import. Click OK. You picture will be placed in the middle of your 
project in the Workspace.

Tip: PrintMaster Gold can import many different types of graphic formats, including CGM, 
TIFF, PSD, JPG, PCX, GIF, WMF, BMP, and Kodak Photo CD.

Acquire an image for your project
PrintMaster Gold includes all the tools youÕll need to acquire photos and graphics to your projects. 
PrintMaster Gold includes TWAIN support so you can easily acquire images from a flatbed scanner, 
digital cameras and more.

Note: Before Acquiring an image in PrintMaster Gold, you will first need to install the scanning 
software and drivers that came with your scanner or digital camera.

To Acquire an image with your scanner or digital camera:

1. Under the File menu, click Acquire. The scanning software that came with your camera or 
scanner will then be launched.

2. Scan your image according to the directions that came with your scanner or digital camera. The 
TWAIN support within PrintMaster Gold will allow you to easily transport that image into 
PrintMaster Gold.

Tip: If your scanned photos look blurry when placed in the Photo project, try scanning them at 
a higher dpi (dots per inch) setting, perhaps at 400 to 600 dpi.

3. Once the image is scanned, you will see the Save Acquired Picture window. Here, type in a 
name for your new scanned image, and if you like, a description of the image. If you would like 
the scanned image to show up in the Art Gallery in the future, click the box at the bottom of the 
window.

4. Click OK. Your scanned image will be placed in the middle of your project in the Workspace.

Adjust an image in PhotoEnhancer



PrintMaster Gold Deluxe and Publishing Suite include PhotoEnhancer, the easy way to manipulate and 
edit your photos. In PhotoEnhancer, itÕs a breeze to get rid of red eye, increase sharpness, adjust the 
brightness of your photos and change colors and textures of your graphic images.

Make sure the image you want to work on is active (the handles are showing around it).

1. Click on the PhotoEnhancer button on the Modify toolbar. The PhotoEnhancer application 
will open with your image in its window.

Note: PhotoEnhancer works only on bitmap graphic files (like BMP, GIF, JPEG, TIFF, etc.).

2. There are two easy ways to adjust your scanned image in PhotoEnhancer, using the Enhance 
and SmartPix menus. 

¥ The Enhance menu allows you to Adjust, Soften, Sharpen, Intensify, and Lighten 
Shadows in your image. 

¥ The SmartPix menu helps fix snapshots that were taken in bad light. Use the selections 
in this menu to correct pictures by the lighting condition in which they were originally 
taken. For example, select the Daylight (Bright) command to correct pictures taken in 
bright sunlight where shadows may have been washed out.

3. If you want to make changes to only a portion of your scanned image, select that portion with 
one of the three selection tools.

4. Once you have selected the area of the image you want to work on, try different menu selections 
in the Enhance or SmartPix menu until you get the effect you want. Remember, you can undo 
any change by selecting Undo in the Edit menu, or press Ctrl-Z.

For Red-Eye Reduction: 
1. You can reduce red-eye in your snapshots by clicking on the Red Eye tool in the PhotoEnhancer 

tool palette. Your cursor will take the shape of a paint brush.
2. Zoom into the image, if necessary.
3. Paint over the red in your subjectÕs eye.
4. When finished, zoom out and your picture will contain no more red eye.
5. After you have made adjustments to your image in PhotoEnhancer, click on Save under the File 

Menu of PhotoEnhancer, then Quit. You will then be returned to PrintMaster GoldÕs 
Workspace, where your adjusted image will be placed on your project.

Note: For more help on using PhotoEnhancer, see Working with PhotoEnhancer below, or click 
on the Help menu within PhotoEnhancer.

Place your image behind the Photo Effect template
Objects on your project are layered in the order in which they are placed on the project. The first object 
placed on your project will be on the bottom, and every object placed after it will be stacked above it.

To get your image to show through the Fun Photo opening, youÕll need to first place it behind the Fun 
Photo.

1. Click once on your image so it is the ÔactiveÕ object in your project (the handles are showing 
around it). 

2. Move your image so the face is approximately over the opening in the Fun Photo.



3. While your image is still active, click the Backward One button on the Place menu. Your 
image should appear behind the Fun Photo. If it does not, click the Backward One button again 
until your image is one level behind the Fun Photo.

Tip: Press the Tab key several times to view the different layers of objects on your project.

4. Click inside the face opening of the Fun Photo. Now you can move the image to align it with 
the opening on the Fun Photo, without bringing it forward.

Resize an image
You may find the face on your image is too big or too small to fit properly in the Fun Photo opening. 
The following steps will help you resize your image so your Photo Project will appear more realistic.

1. Make sure your image is ÔactiveÕ (handles showing around its edges). If it is not, click inside 
the opening of the Fun Photo, directly on your image, to make it active. If you are having 
trouble selecting your image, hit the Tab key to cycle through the different levels of objects in 
your project until your image is active.

2. Once your image is active, place the cursor on the handle (the small square box) on the bottom 
right corner of the image. You can now drag the mouse diagonally out and down to make the 
image larger. To make sure the image keeps its exact proportions, hold down the Control (Ctrl) 
key while dragging.

Crop a photo image
Your scanned image may be too large or include things youÕd like to crop out. PrintMaster Gold has a 
cropping tool that allows you to see only the portion of the photo you want to see, without removing or 
disturbing any part of the image.

To crop your image:
1. Make sure the image you want to crop is active (handles are showing around its edges).
2. Click the Crop tool on the Modify toolbar.
3. Place the cursor over any handle of the image. The cursor will turn into a cropping tool. You 

can now drag the handle to create a new window through which you will view your image. 

Note: You are not altering the image, you are just reducing or enlarging the ÔwindowÕ 
through which you can see that image.

4. With your image still active and the cropping tool button selected, place the cursor over the 
center of the image image. The cursor will turn into a ÔmoveÕ hand. By clicking and dragging 
your image, you can move the image within the cropped window to see only the portion of the 
image you want.

Tip: When you click on an object, make sure you click on an opaque part of each object. If you 
click on a clear or transparent part of an image, you will most likely select the object 
underneath it.

Save your Photo Project
LetÕs save your Photo Project with a unique name and attributes so you can easily find it in the future.



1. Click the Save button on the Global toolbar. To save an existing Photo Effect project under a 
new name and description, select Save As... from the File menu. PrintMaster Gold will then 
prompt you to type in a new file name and description.

2. Type in the new File Name into the box provided.
3. You may also attach a short description to your Photo Effect project by typing it into the 

Description box. Or, you can add new words to the keyword list so you can more easily search 
for it in the Ready Made Gallery.

4. To change the default drive and/or directory that your project will be saved to click Change... 
and select the new destination.

5. Click OK or press ENTER to save your Photo Effect project project.

Tip: If you would like to print your Photo Project on to an iron-on transfer, first select all the 
items on your project (Ctrl-A), Group them (click Group button), then click the Mirror button so 
all of the objects are flipped. Now, when you iron the images on to a T-shirt, they will appear 
correctly.

Design Tips from the Pros

ÒIÕve found the best way to make a Photo Project is to first look for a snapshot of one of my 
friends that is bright and clear. Then I scan the photo at a high a resolution as I can--usually 
around 600 to 700 dpi works best--so I can make the image larger in PrintMaster Gold without 
distorting it or making it look jagged.Ó Ben Atley - Designer

Newsletter Tutorial

PrintMasterÕs Newsletter Ready Mades can help you create sharp, colorful newsletters fast. Our Ready 
Made templates include all the pieces you need: headlines, columns, connected text boxes, and 
graphics. Plus, PrintMasterÕs newsletter project can be used to create bulletins, newspapers, reports, 
and other multi-page documents.

NOTE: Newsletter projects are not available in PrintMaster Gold Classic.

This newsletter tutorial will show you how to:
¥ Open a Ready Made Newsletter template
¥ Create a new Newsletter
¥ Connect Text Boxes
¥ Disconnect Text Boxes
¥ Insert Additional Pages in your Newsletter
¥ Save a Newsletter project
¥ Print a Newsletter project.

Open a Ready Made Newsletter template
The PrintMaster Gold Ready Made Gallery provides many different categories of Newsletters from 
which you may choose.



1. From the Hub screen, click Ready Made. If you are in the Workspace, click the Ready Made 
button on the Global button bar. You will be taken to the Ready Made Gallery. To narrow your 
search for an appropriate newsletter design, choose a Category, Tone, and Style.

A larger display of a newsletter can be viewed by clicking the View menu at the bottom of the 
Ready Made Gallery window and selecting the Large option. You can then scroll through the 
pages of the newsletter template by clicking on the Page View pop-up menu. To return to the 
standard preview open the View menu again and select View Medium.

2. Once you find the newsletter design you want in the Ready Made Gallery, click on it, then click 
Select (or double-click your selection). The newsletter you selected will then be placed in the 
Workspace, ready for you to replace the sample text and graphics.

Tip: Prioritize information in newsletters and brochures. Establish areas with current news 
ÔbitesÕ to hilite events or set off helpful tips. Breaking up longer, in-depth stories with shorter, 
fast-paced ones establishes a good information flow and helps keep the readerÕs interest.  Pete 
Russitano - PrintMaster designer

To create a new Newsletter:
1. Click the Brand New button in the Hub.
2. When creating a new newsletter, you will be prompted to select a page layout for your new 

project. Use your mouse to select the Newsletter Size.
¥ The Size option Tall (or Portrait) prints text across the short width of the paper.
¥ The Size option Wide (or Landscape) prints text across the long width of the paper.

3. Once you have selected the newsletter size, click Finish. Your blank newsletter will be placed in 
the Workspace, ready for you to enter your own text and graphics.

Connecting Text Boxes
When typing long passages into a text box, the text may run longer than fits in the box you have 
created. The extra text isnÕt lost, you just canÕt see it within the frame of the text box. When your text 
overflows the text box, you can connect to another empty text box anywhere in your newsletter, so the 
text will flow from one box to the other.

1. Click the Link icon at the bottom of your first text box. You will notice if you then move the 
cursor over the text, it will become a Text Pour icon. You can now pour the overflow text into 
any other empty text box.

2. Click into an empty text box where you want the overflow text to go.

Note: You cannot connect two text boxes with the Text Pour icon if the destination text box has 
text in it.

Viewing All Connected Text Boxes: You can view all connected text boxes by clicking on the 
Previous or Next Text Box arrows at the top and bottom of each active text box. Click the right arrow 
(New Text Box) to view the text box that contains the overflow from that box. Click the left arrow 
(Previous Text Box) to view the text that comes before the text in that box.



Tip: Small, neatly placed icons or pictograms, when used with a primary design element (like 
color boxe) can help illustrate difficult concepts, such as travel, time, technology, and emotions. 
Pete Russitano - PrintMaster designer

Disconnecting Text Boxes
To disconnect two connected text boxes:
1. Click on the first text box you would like to disconnect. The text box will display a Next Text 

Box button (right arrow), showing that it is connected to another text box.
2. Click on the Link button. The cursor will again turn into the Text Pour icon.
3. You can then either:
¥ Click inside the text box, disconnecting that text box from all following boxes. The text will 

now stay within that text box, or 
¥ Click into another empty text box, connecting the text to the new text box.

Inserting Additional Pages
One of the unique features of a Newsletter project is the ability to work with multiple pages. To insert 
additional pages to your Newsletter proceed as follows:

1. Pull down the Add menu with your mouse and select Pages (or press ALT+A+A on your 
keyboard).

2. In the dialog displayed, type in the number of pages to add.
WhereÑUse this option to determine the placement of additional pages. Choose either:
¥ Before Current Page
¥ After Current Page
ContentsÑUse this option to add the type of pages to your Newsletter. Choose either:
¥ Add Blank Pages
¥ Add Copies of PageÑUse this option to duplicate existing pages by typing in the page number 

of section to duplicate.
3. Press ENTER or click OK to add your new pages.

Hint: To add pages quickly, click on the right arrow of the View Page window (at the bottom of 
the screen) while viewing the last page of your newsletter. This will bring up the Add Page 
dialog box, where you can add a page or pages to your project.

Save Newsletter
This command will enable you to save your Newsletter project with a unique name and description that 
you provide.

1. Click the Save button located on the Global toolbar. To save an existing Newsletter project 
under a new name and description, select Save As... from the File menu. PrintMaster Gold will 
then prompt you to type in a new file name and description.

2. If you are saving a new Newsletter project, PrintMaster Gold will prompt you for a unique file 
name. Type in the new File Name into the box provided.

3. You may also attach a short description to your Newsletter project by typing it into the 
Description box. You may also enter keywords so you can search for your newsletter in the 
Project Gallery.

4. To change the default drive and/or directory that your project will be saved to click Change... 
and select the new destination.

5. Click OK or press ENTER to save your Newsletter project.



Print Newsletter
This option brings up the Print dialog enabling you to print your Newsletter project. From this dialog 
you can also choose the number of printed copies, the print quality, and other features.

1. Click the Print Newsletter button to display the Print dialog box.
2. Click Print to begin printing your project.
Print RangeÑUse this option to select what pages of your multi-page document to print.

Double-Sided Printing Wizard
PrintMaster Gold includes an easy-to-use Double-Sided Wizard to help you determine the best way to 
print your double-sided print projects.

The Double-Sided Print Wizard takes you step-by-step through a sample printing project, and 
according to your responses, configures PrintMaster to print double-sided projects automatically in the 
future.

1. Once your double-sided project is completed, select the Print button on the Global menu or 
type Ctrl+P. 

2. Make sure Double-sided is checked on the Print dialog box. 
3. Click Print. The first time you print a double-sided project, you will see the Double-Sided 

Wizard. If you have not yet set your double-sided print configuration and the Wizard does not 
appear, select Double-Sided Print Setup... under the File menu.

2. The Double-Sided Print Wizard will first ask you to print a 2-page test project. After the two 
pages are printed, follow the directions on the Wizard screen. You will be asked to match the 
printed pages to icons on the Wizard screen, place the pages back in the printer, print again, 
then select the configuration that matches the final print out order.

3. Once you have answered the questions on the Wizard screen, click Finish. PrintMaster Gold 
will now be configured for subsequent double-sided printing. You can now print multiple-page, 
double-sided projects such as newsletters, cards, and envelopes.

Address Book and Label Tutorial

PrintMaster GoldÕs Address book is an easy way to keep track of names, addresses, and birth dates, 
then merge that information into all types of projects. The Address Book, used with Fill-in Fields, can 
print dozens of personalized holiday cards for all your relatives, invitations for your friends, labels for 
your customers, or certificates for your students.

In this tutorial, you will learn how to create an Address Book, then youÕll use the Address Book 
entries to create your own custom labels.

NOTE: The Address Book is not available in PrintMaster Gold Classic.

This Address Book and Label tutorial will show you how to:
¥ Create a new Address Book
¥ Create a new Label
¥ Open a Ready Made Label



¥ Add Fill-in Field to your Label project
¥ Apply values to the Fill-in Fields
¥ Save your Label project
¥ Print your Label project

Creating a new Address Book
The Address Book is a good way to electronically keep track of names, addresses, birth days, and other 
information. The best thing about PrintMaster GoldÕs Address Book is that itÕs an easy and powerful 
way to merge the names and addresses of your friends, family, or other acquaintances into any 
PrintMaster Gold printing project!

The following instructions describe how to create a new Address Book.

1. From anywhere inPrintMaster Gold, pull down the Tools menu with your mouse and click on 
Address Book, or press ALT+T, A on your keyboard.
If you have not already created an Address Book, PrintMaster Gold will start you off with a 
blank address book called: Address. You can edit this address book or click New under the 
Address Book File menu and create your own using a different name.

2. Use the displayed fields to begin entering the basic information for each person youÕre adding 
to your Address Book. You can fill in any fields you want, but it is best to include at least the 
First Name and Last Name. The available fields are:

¥ First Name, Last Name
¥ RelationshipÑUse the pull down menu to select one of the predefined values for this field or 

type in your own. New values typed in will be added to this menu so that you may select 
them again for use with other Address Book entries.
The Relationship field can also be used to sort records in your Address Book.

¥ Title, Company, Address1, Address2, City, State, Zip
¥ CountryÑUse the pull down menu to select one of the predefined values for this field or 

type in your own. New values typed in will be added to this menu so that you may select 
them again for use with other Address Book entries.

¥ Phone, Fax
¥ EmailÑUse this field to type in an Internet email address.
¥ Birthday, Anniversary
¥ CommentsÑUse this field to type in generic data or personal comments. 
¥ Picture ÑUse this field to add pictures of friends, family members, or employees to your 

Address Book.
¥ User Defined InfoÑUse this field to enter important data not covered by the standard fields 

listed above.
¥ User Defined DateÑUse this field to enter dates not covered by the standard fields listed 

above.
3. Click the New button to begin working on a new record for your Address Book. Use Tab and 

Shift+Tab to navigate to the next field or backup to a prior field.
4. Click the Save button to add a completed record or save changes to an existing. To remove an 

entry click Delete button. To reverse changes made to a record click the Undo button.

Creating a new label
Now that you have some information in your Address Book, letÕs create a label and have PrintMaster 
Gold automatically insert your Address Book information into each label.



PrintMaster Gold makes it easy to create dozens of different types of labels for envelopes, floppy disks, 
video cassettes, name tags, and many more.

To create a new label:

1. From the Hub screen, click Brand New. Then, in the New Project dialog box, choose Label.
2. You will be prompted to choose a Label Type.

¥ Select Laser Labels if you will be printing your labels on a laserjet, inkjet, or bubblejet 
printer.

¥ Select Dot Matrix Labels if you will be printing your labels on a dot matrix printer.
3. From the provided list, pick the specific type of labels to be used. Click OK to begin editing 

your Brand New label in the Workspace.

Open an existing Label
1. From the Hub screen, click Ready Made, then, under Project Type, choose 

PrintMaster/Label.
2. Browse through the Ready Made labels to find one you like. To narrow your search, select a 

Category and Style. Remember, you can make as many adjustments as you like to the Ready 
Made label once you enter the Workspace.

3. Once you have found a Ready Made label you like, click once on the label, then click Select (or, 
double-click the label preview). You will then be taken to the Workspace where you can work 
on your Ready Made label.

Note: The Ready Made label you chose in the Ready Made Gallery may not represent the label 
type you desire. To change the label type, click Edit in the menu bar, and click Choose Label 
Type (or, press Alt-E, Y). Then choose the label type you desire from the list presented. You may 
have to make adjustments to text size and graphic placement if the new label size is 
considerably different from the original.

Adding Fill-in Fields to your label project
Fill-in fields are placeholders that can be Òfilled-inÓ with personal information from your Address 
Book or with any information you type-in. To add a fill-in field to your label project, proceed as 
follows:

1. Begin by adding a text box to your label project. If you are working with a Ready Made project, 
delete the sample text in the text box, but leave the empty box.

2. Make sure the empty text box is active (the handles are showing around it), and the insertion 
point (the blinking cursor) is placed inside the text box.

3. Under the Add menu, select Fill-in Field. A list of available fill-in fields will be displayed at 
this point. Use the scroll bar to the right to move up or down the list of fields.

Tip: To quickly add Fill-In Fields, right click on the active text box and select Add Fill-in 
Field...

4. Pick a fill-in field by clicking on its name.
5. Click the Insert button to add the selected field to your project page.
Or, to more easily insert standard information:

¥ Click the Receiver Address button to automatically insert Receiver First Name, Last 
Name, Title, Company, Address1, Address2, City, State, and Zip fields. This is often the 



best selection when you are sending out lots of mailers, envelopes, or invitations with a 
different name and address on each item.

¥ Click the Sender Address button to automatically insert the Sender First Name, Last 
Name, Title, Company, Address1, Address2, City, State, and Zip fields. This will create 
a series of labels with your name and address on each. This is best when you want to 
create many identical return address labels, cassette labels, books plates, or business 
cards.

6. To insert additional fields, repeat steps 4 and 5.

Note: Fill-in Fields do not have to be inserted into an empty text box. They can also be added to 
text boxes that already contain existing text. Fill-in fields are inserted at the text cursor 
position.

Applying Values to Fill-in Fields
Once you have placed fill-in fields onto your project page you will need to assign values to each of the 
inserted fields.

1. To begin, select Fill-in Fields in the Edit menu.
A list of the field names used in your project will appear on the left side of the dialog box. To 
the right a space will be provided for typing in values for each of the fill-in fields.
You may enter your own values for each field, or you can select values from the Address Book 
so your Address Book information will be merged automatically.

2. To edit a field, simply click on the field with your mouse and begin typing in the desired data.
¥ Use Tab and Shift+Tab to move to the next field or to backup to a prior field.

3. To automatically merge information from the Receivers List of your Address Book, click the 
Receivers... button.

4. Pick the receiver name(s) you wish to use by clicking on them with your mouse. Once you have 
chosen the desired name(s), click OK.
¥ Or, click All to have all the names in your Address Book merged into your project.
Note: When selecting multiple receiver names, only one of the chosen names will be displayed 
on the project page (generally the first one selected). You will also only see one name listed in 
Print Preview. However, upon printing your project each printed page will contain a different 
receiver name.

5. Click OK to return to your project page.
Note that the fill-in fields seen earlier have been replace by the first name in the receiver list you 
selected. At this point you can now begin editing your text by changing items like font, color, 
size etc.

Print Label
This option brings up the Print dialog enabling you to print your Label project. From this dialog 

you can also choose the number of printed copies, the print quality, and other features.
1. Click the Print button on the Global toolbar or hit Alt+F, P on your keyboard to display the 

Print dialog box.

The following buttons are available on the Print dialog box:
The Fill-in Fields... 
This button allows you to make changes to the number of names that will be printed. To the right of the 
Fill-in Fields button is an indication of how many Fill-in fields PrintMaster Gold has retreived from 



your Address book. To change that number, click the Fill-in Fields... button and re-select names from 
your Address Book.

Number of Labels:
This button allows you to choose how many of each name merged from your Address Book to print 
out. For example, if you are merging three names from your Address Book, you can choose to print 
each name twice by typing Ò2Ó in the Number of Labels box.

Starting Label...
Use this item to specify the starting label on any printout. This feature is useful when printing to a page 
containing only a partial number of labels. On printouts consisting of multiple pages, this feature will 
only apply to the first page. Any additional pages will start printing on the first label.

2. Click Print to begin printing your project.

Design Tips from the Pros

Fonts for mailing labels should be clear and bold and be at least 10 point or larger, even for small 
return address labels. IÕve found itÕs very professional looking to add a small graphic in the upper left 
corner of my address labels that also matches my letter head. It gives my packages a professional, 
coherent look. I do not, however, put any color behind the text. Color often makes small text hard to 
read.      Macy Alpin - designer

Calendar Tutorial

With PrintMaster Gold you can design a Calendar to fit in your wallet or fill a bulletin board. Monthly, 
weekly, and generic calendar styles are available and any day can be enhanced with both text and 
pictures.

The following instructions describe how to 

¥ Create a new Calendar project
¥ Open an existing Calendar project 
¥ Add text to a date
¥ Add pictures to a date
¥ Copy Date information
¥ Review the Calendar menu options
¥ Save a Calendar project
¥ Print a Calendar project.

Beginning a Calendar
1. In the Hub screen, click Brand New, select a Calendar project, and then click Next.
2. When creating a new Calendar, you will be prompted to select a page layout for your new 

project. First, use your mouse to select the Calendar Size.
¥ The Size option Tall (or Portrait) prints text across the short width of the paper.
¥ The Size option Wide (or Landscape) prints text across the long width of the paper.



3. Next, choose the desired type. PrintMaster Gold supports three Calendar Types.
¥ Monthly Calendars show a full month of dates.
¥ Weekly Calendars show a single week of dates.
¥ Generic Calendars are weekly Calendars without any specific date numbers.

4. Select the Calendar date (Month and Year. Also choose the Week for Weekly Calendars). 
Click the Now button to select todayÕs date. PrintMaster Gold will automatically label each 
day of Monthly and Weekly Calendars with the proper numbers based on the selected date.

5. Click Finish or press ENTER to begin editing your Calendar project.

To open an Ready Made Calendar:
1. From the Hub screen, click Ready Made. 
2. In the Ready Made Gallery, choose PrintMaster/Calendar. Under Category, you can choose 

either Monthly calendars or Weekly calendars. If you would like to narrow your search, choose 
the Tone or Style of the calendar you are looking for.

2. Highlight a Calendar project by clicking on its preview. To see other Calendar projects within 
the same category, scroll down the Ready Made Gallery preview screen.

3. Once you have found a calendar you are interested in, click the preview once, then click Select. 
Or, double-click the preview. You will then be taken to the Workspace.

Adding Text to a Date
Text can be added to a particular date by simply double-clicking on the date box with your mouse. 

Note: You may want to zoom in on the date you wish to add text to.

Adding a Picture to a Date
You can attach any picture to a date box. 

1. Right-click the mouse button over any date of your Calendar project. 
2. On the popup dialog, select Choose Date Picture... You will be taken to the Art Gallery, where 

you can choose your picture. 
Note: Only a single picture is allowed per date and the picture is always sized to fit the box.

Tip: Repeating elements on a page can create an exciting atmosphere. Change the size, color, 
tint, placement, and layer position of each repeated element to keep it interesting. This works 
great with snowflakes, balloons, flowers, Holiday ornaments,and even text.  Pete Russitano - 
PrintMaster designer

Change Picture Color
To change the color shading of a picture attached to a date box, right click on the date box to bring up 
options to change Picture Color or Picture Attributes.

Copy Date Information
To copy the contents of one date box to another, click on the date box you want to copy and while 
holding down the left mouse button, drag the date box to the new destination. When you release the 
mouse button, the text and pictures will be copied.

Changing Calendar Information



Additional features for editing your calendars are available on the Calendar menu located at the top of 
the project screen. Open this menu by click on its name or by pressing ALT+C.

Month and Year...
Use this option to change the Month and Year of your Calendar project. For Weekly Calendar projects 
your can use this option to change the week. PrintMaster Gold will automatically number the days for 
the date your choose.

Calendar Style...
Use these options to customize the look of your Calendar project. Click the Default button to reset all 
items to their original values.

Weekday Names
Use this option to edit the style of weekday names. Three variations of weekday names are 

offered:
¥ Text Only displays only the weekday names.
¥ Boxed Text displays the weekday names in boxes.
¥ Reversed Text displays the weekday names on a black background.
Weekday Spelling
Use this option to specify the spelling of the weekday names. Three variations are supported:
¥ Initials displays the weekday names as S, M, T, W, T, F, S.
¥ Abbreviations displays the names as Sun, Mon, Tue, Wed, Thu, Fri, Sat.
¥ Full Names displays the weekday names as Sunday, Monday, Tuesday, Wednesday, 

Thursday, Friday, Saturday.
Lines
This option controls what lines are drawn around the Calendar date boxes. Lines does not 

effect any box drawn around weekday names.
¥ None displays no Calendar lines.
¥ Horizontal displays only horizontal lines.
¥ All Lines displays all Calendar lines.
Line Color
Click this button to choose the color for the lines drawn around the Calendar date boxes, the 

box drawn around the weekday names, and a color shadow.
Shadow
This option is used to add a shadow effect to your Calendar.
¥ No Shadow turns off any shadow effect.
¥ Black adds a black shadow to the Calendar.
¥ Gray adds a gray shadow to your Calendar.
¥ Light Gray adds a light gray shadow to your Calendar.
¥ 100%, 50%, 25% Color adds a shadow of the chosen Line Color (see above) to your 

Calendar. The color is rendered at the selected percentage.
Outline
Select this option to add an outline around the entire calendar.

Edit Calendar Title Text
Use this option to edit the contents and style of the Calendar title. You can also edit the title by clicking 
on the project layout area with your mouse.

Date Number Font...
This option enables you to change the font style of the date numbers on your calendar.

Weekday Name Font...



Use this option to change the font style of the weekday names (Mon., Tues. Wed., etc.).

Edit Date Text
This option enables you to edit the text inside of a date box.

Choose Date Picture...
This option enables you to attach a picture to a date box. Only a single picture is allowed per date and 
the picture is always sized to fit the box.

Date Picture Color...
This features enables you to change the color shading of a picture attached to a date box.

Date Picture Attributes...
This option enables you to adjust attributes (color, render method, etc.) of the selected picture. (See the 
chapter entitled: Working with Pictures later on in this guide for more detail.)

Clear Date
Use this option to remove text and picture elements only from the currently selected date. Other dates 
will remain unchanged.

Design Tips from the Pros

Soft, mutued colors are an important way to achieve subtle feelings in a design. They can soothe, 
warm, soften, add elegance and emotion, and are a welcome departure from the bright, jarring images 
of the day.  Pete Russitano - PrintMaster designer

User Tip:

I once used the calendar project for my girlfriendÕs birthday, and it worked out great. Every day for 
two weeks, I printed out the same calendar with a new greeting at the bottom and another day crossed 
off. Then, every day I sent it to her. On the last day, I brought the last calendar to her office with roses. 
I think she liked the anticipation of the event as much as its arrival.   Bob Alewon - PrintMaster user


	Tutorials
	Card Project Tutorial
	LetÕs get started! One of the most versatile and fun projects in Printmaster Gold is the card project. But, donÕt let the name fool you--ItÕs not just for cards. In card projects, you can create invitations, programs, or menus.
	To get your feet wet, letÕs start with a card that already has art, sentiments, and size chosen for you--what we call a Ready-Made. Remember, no Ready-Made is set in stone. In PrintMaster Gold, you can make just about any change you want, from turning a Birthday Greeting into a Get Well card or a Get Well card to an invitation.
	In this card tutorial, we will:
	¥ Introduce the Hub Screen
	¥ Introduce the Ready Made Gallery
	¥ Select a Ready Made Birthday card
	¥ Edit text
	¥ Check spelling
	¥ Move a picture
	¥ Resize a picture
	¥ Rotate a picture
	¥ Add a new picture from the Art Gallery
	¥ Add a new sentiment from the Sentiment Gallery
	¥ View, save, print, and fold the card
	Selecting a Ready-Made Card Project


	After you launch PrintMaster Gold, youÕll land in what we call the Hub.
	This is where it all starts. If you know exactly what you want and want to design your project yourself, you might start with Brand New. If you are a little unsure and wanted guidance every step of the way, you might choose With Help.
	For now, letÕs go with a Ready-Made. Here, weÕll take a look at some of the thousands of cards our vast team of artists have already created. Then, weÕll make a few changes to make it our own.
	1. Click on Ready-Made.

	The Ready-Made button takes you to the Ready-Made Gallery:
	HereÕs where you choose your project type, category, tone, style, and media. If you have an idea of what youÕre looking for (like ÒFatherÓ or ÒBirthdayÓ), you can type the word in the Keyword box and click on Find Now. PrintMaster Gold will search for all the projects that match your request.
	2. In the Project window, select PrintMaster/Card.
	3. In the Category window, select Birthday. Your Gallery menu will look like this:
	Browsing the Cards


	Several thumbnail selections will appear in the Gallery window to the right of the Gallery menu. To see more Card projects within the same category, scroll down the selection or click the View Size Window on the bottom of the Gallery window.
	Note: A larger view of the card is available by clicking on the View Size menu at the bottom of the Gallery window.
	Note: You can also search for a project by using the Keyword search. Type in any word into the Keyword box and PrintMaster will find all the projects that match your request. Use the star (Ò*Ó) wildcard to find all versions of the word you are searching for. For example, ÒSport*Ó will find not only ÒSportÓ, but ÒSportsÓ and ÒSportsmenÓ.
	4. Select the card you like by clicking on it once so it is highlighted, then click on the Select button at the bottom left of the Gallery menu. Or, after selecting the card, click the ENTER key or double-click the preview.
	Personalizing your card

	After selecting the card you want to work on, youÕll be taken to the Workspace. The Workspace is like a drafting board, with all the text, drawing, and positioning tools youÕll need to personalize and adjust your Ready-Made.
	Editing Text

	The card you picked might have had a fun headline, but youÕre sure you can write something even better. No problem. LetÕs make some adjustments to the text.
	1. To edit the headline, click once on the text. Notice the insertion point blinks where you clicked between the letters. Also, notice six ÔhandlesÕ have appeared around the text box. You can use these handles to reshape your text box. Notice also that in the text menu above the card, the text status bar is updated: it tells you the font, the size, and the style of your headline.
	2. Highlight the text you want to change by holding down the left mouse button and dragging across the letters. Type in the new text (for example, ÒDear Friend: DonÕt fight it. YouÕre ancientÓ).
	Check the Spelling of your card

	PrintMasterÕs spell checking feature will find misspelled words anywhere in your project.
	1. Click the Check Spelling button on the Global toolbar. The Check Spelling window will appear. If it has found a misspelled or unfamiliar word, it will be highlighted in the top field of the window. If the Check Spelling feature does not find a misspelled or unfamiliar word, the window will not appear.
	2. Notice the list of Suggestions. If one of those words is the correct spelling of the word highlighted, select it and click Change. If you do not want to change the spelling, click Ignore or Ignore all if there are other occurences of the word in the project.
	Adjusting pictures

	Perhaps you like the pictures on your Ready-Made card, but youÕd like to move them around a bit. No problem.
	1. Click on a picture on your card. Be sure to click directly on an opaque section of the picture, and not on the background behind it. Once you click on it, you will notice again that handles appear on the edges of the picture boundary. ThatÕs how you know itÕs ÔactiveÕ.
	2. When the cursor is now over the opaque section of the ÔactiveÕ picture, the cursor turns into a Ômove cursorÕ. It looks like cross-hairs. That means you can now move the picture by holding down the left mouse button and dragging the picture wherever you want. Note: You can also move the active picture, pixel by pixel, by using the arrow keys.
	Hint: In general, itÕs more effective to keep people and other images from facing off the page. Instead, try facing them towards the sentiment or other elements. This helps keep the focus on the important components of the design.
	3. To resize a picture, drag one of the handles located on the outside edge of the pictureÕs boundary box out to make it larger, or drag it in to make it smaller.
	Hint: ItÕs usually not a good idea to resize bitmapped pictures. YouÕll see they get garbled and Ôstair-steppyÕ.Ó
	4. To rotate the picture, make sure the picture is active (the handles around it are showing). YouÕll notice that when your cursor passes over one handle on its side, the cursor turns into a rotating arrow. This is the Ôrotate handleÕ. Now drag the rotate handle around the picture to the angle you desire.
	Hint: the objects on your project are placed in layers. The first object is on the bottom, and each object placed above it, one by one. To view each object by layer, repeatedly hit the Tab key. Once the object your are interested in becomes active, you can work on it (adjust its size or color, for example) without changing its order in the stack.
	Adding pictures

	After making adjustments to your pictures, you may now want to add another picture to make it your own special creation. ItÕs easy.
	1. To add a picture to your card, click on the Add Picture button on the left menu bar. The Art Gallery will replace the Workspace:
	2. Choose a Category, Tone, Style, and Media for your new picture. Or, if you want to search for a picture using Keywords, type a few words into the Keywords window and click OK.
	Note: use the star (Ò*Ó) wildcard to find all versions of the word you are searching for. For example, Òbrid*Ó would find not only ÒBirdÓ, but ÒBirdsÓ and ÒBird BathÓ.
	3. Select the picture you want by clicking on it twice in the Gallery window. Or, click on it once so it is highlighted, then click Select on the menu bar.
	4. The Art Gallery will disappear and your picture will appear in the middle of your card. You can now move it or adjust it using the techniques described above.
	Hint: Enlarging the cover image to fill the front and back of your card, edge to edge, can be a great way to make your ÒcanvasÓ appear larger.
	Adding Sentiments

	Perhaps youÕve decided the quote on your card is OK, but not just right. ItÕs easy to change it with our Sentiments Gallery. There you can leaf through the thousands of sayings, quotes, and jokes created by our witty scribes.
	1. To add a new sentiment to your card, first click on the existing text on your card and delete it. Then click on the Sentiment Gallery button on the left menu bar. The Sentiment Gallery will above the Workspace.
	2. Choose a Category, subcategory, and Tone you are looking for, or search for a specific sentiment using Keywords.
	3. Select the Sentiment you want by clicking Select.
	4. You will be returned to the Workspace and your Sentiment will appear in the middle of your card. Note that some quotes include both a ÔfrontÕ quote that only appears on the front of cards, and an ÔinsideÕ quote that will appear on the inside of the card. You can move the text or adjust it using the techniques described above.
	Tip: If the cover of your card is strong enough, you donÕt need to place any text on it. By placing the sentiment only inside the card, you increase its impact. Sometimes, less really is more.


	Viewing work
	Selecting a Panel:
	Cards are made up of four separate panels comprising the front, back, and inside surfaces of the card. Each panel can have its own background, text, and picture elements. You can select the Card panel you want to view by clicking on the View Face menu at the bottom of the Workspace.
	Tip: Add some punch to your design by using contrasting emotions inside and out. A serious, business-related cover that gives way to a happy, carefree payoff inside generates surprise and can really brighten someoneÕs day.


	Zooming in and Out
	You can look closer at your card by clicking on the zoom button (magnifying glass with +-sign). Or, you can click and hold down on the View Size menu at the bottom of the Workspace and go to 100%, 200% or any other percentage you want.
	Note: You can also zoom in to your project in the Workspace by typing the plus (Ò+Ó) key and zoom out by typing the minus (Ò-Ó) key on the number pad of your keyboard.


	Print Preview
	You can view your project before printing by clicking the Print Preview button on the Global Toolbar. In the Print Preview menu, you can zoom in, zoom out, and print your project.

	Save Card
	Now, before we print, itÕs time to save your project.
	1. Click the Save button located on the Global menu at the top of your screen, or hold down the File menu, and go to Save. PrintMaster Gold will prompt you for a unique file name.
	2. Type a name into the box provided. You may also attach a short description to your card project by typing it into the Description box.
	3. To change the default drive and/or directory that your project will be saved to, click Change... and select the new destination.
	4. Click OK or press ENTER to save your card project.

	Save Picture Files in Project: This feature is particularly useful when using pictures that are selected from a floppy disk or CD, or when you expect to place your card on a disk and pass it to a friend. When Save Picture Files in Project is selected, PrintMaster Gold will not require you to insert the floppy disk or CD containing the picture(s) used the next time you or your friend opens your project.

	Print Card
	YouÕre almost done! As the last, and most rewarding step, letÕs print your project.
	1. First, make sure your printer is turned on and you have selected the correct paper size in Print Setup (under the File menu).
	2. Click the Print button to display the Print dialog box. From this dialog you can also choose the number of printed copies, the print quality, and other features. See the chapter 8, Printing a Project, for more information.
	2. Click Print to begin printing your project.


	How To Fold A Card
	Card projects come in all shapes and sizes: wide, tall, big, and small. Ultimately, the size of your card will depend on what sizes are supported by your printer, and the paper size you choose. Here are three ways you can fold your card (determined by the type of card youÕve chosen).
	Quarter Fold

	A quarter-fold card is made from regular 8 1/2 x 11 paper, folded into fourths. It prints on one side of the paper and may be either horizontal or vertical.
	1. For either a vertical or horizontal card, fold the paper in half across the middle, with the printing on the outside.
	2. Fold the paper in half again.
	Single Fold

	A single-fold card is folded once, in half. It may be either horizontal or vertical. For a nicer looking card, print the outside on heavier paper and the inside on lighter paper. Then fold them together, placing a bit of glue on the front inside face of the card to hold the lighter paper in place.
	Z Fold

	A Z-fold card prints on one side of the paper and folds into a brochure. It is always vertical.
	1. Fold the front third of the card with the printing on the outside.
	2. Fold the inside of the card by aligning the edge of the paper with the fold made in Step 1. You can now use a bit of glue to seal the front to the middle face.


	Return to the Hub
	Now that youÕve created and printed your first card, we can return to the Hub, where you can chose another Ready-Made card or try any of the hundreds of other projects waiting for you.
	1. Click the Close button to exit the Workspace and return to the Hub. If you have not already saved your Card, you will be prompted to do so at this point.

	Design Tip from the Pros
	ÒThe receiver of a card usually expects to see the front text near the top of the card. TheyÕll read it quickly, then flip to the ÔzingerÕ quote inside. So, itÕs not a good idea to scatter text all over the front of a greeting card.... ItÕs also a good idea to have the text on the front of the card line up visually with the text on the inside the card. The eye tends to stay at the same place when the card is opened.Ó
	Lori Saulsen, greeting card designer
	PrintMaster Gold User Tip
	ÒI make my Mom a birthday card every year. Every year itÕs just a little different, but every one of them includes one thing: a rose. Every year, a rose turns up somewhere--behind the headline, behind a tea kettle graphic, or maybe even on the back--but itÕs there. ItÕs become a bit of a game for Mom to find it. But I know she loves roses, so I wouldnÕt ever send her a card without at least one.
	Martin Mulon, Oklahoma City, OK

	Photo Project Tutorial
	Ever wondered what you would look like as a cowboy or the President of the United States? Photo Projects are a fun way to create pictures of you or your friends in fun scenarios, scenes, and poses. All you need is a Photo Project and a picture of your friend. YouÕll be surprised at the effect!
	Select a Ready Made Photo Project
	1. From the Hub screen, click Ready Made. If you are in the Workspace, click the Ready Made button on the Global button bar. You will be taken to the Ready Made Gallery.
	2. In the Ready Made Gallery, select PrintMaster/Photo under Project Type. PrintMaster Gold offers several different categories of Photo projects from which you may choose. If you would like to narrow your search, choose a Category, Tone, and Style.
	3. Find the photo project you like, select it, then click Select (or, double-click on your selection). Your selection will then be placed in the Workspace.
	Import your picture file from disk


	The Photo project is comprised of Fun Photo, text, and graphic elements. The photo has been altered to allow you to place a picture of you or your friendÕs face behind it, creating the illusion that the face is attached to the body in the picture.
	1. Open the Art Gallery by clicking on the Add a Picture button on the Add menu.
	2. Once you are in the Art Gallery, click on Open from Disk under the File menu. You will then see a dialogue box. If your file is not displayed in the window, scroll down to the appropriate path.
	3. Select the file you want to import. Click OK. You picture will be placed in the middle of your project in the Workspace.
	Tip: PrintMaster Gold can import many different types of graphic formats, including CGM, TIFF, PSD, JPG, PCX, GIF, WMF, BMP, and Kodak Photo CD.
	Acquire an image for your project


	PrintMaster Gold includes all the tools youÕll need to acquire photos and graphics to your projects. PrintMaster Gold includes TWAIN support so you can easily acquire images from a flatbed scanner, digital cameras and more.
	Note: Before Acquiring an image in PrintMaster Gold, you will first need to install the scanning software and drivers that came with your scanner or digital camera.
	To Acquire an image with your scanner or digital camera:
	1. Under the File menu, click Acquire. The scanning software that came with your camera or scanner will then be launched.
	2. Scan your image according to the directions that came with your scanner or digital camera. The TWAIN support within PrintMaster Gold will allow you to easily transport that image into PrintMaster Gold.
	Tip: If your scanned photos look blurry when placed in the Photo project, try scanning them at a higher dpi (dots per inch) setting, perhaps at 400 to 600 dpi.
	3. Once the image is scanned, you will see the Save Acquired Picture window. Here, type in a name for your new scanned image, and if you like, a description of the image. If you would like the scanned image to show up in the Art Gallery in the future, click the box at the bottom of the window.
	4. Click OK. Your scanned image will be placed in the middle of your project in the Workspace.
	Adjust an image in PhotoEnhancer


	PrintMaster Gold Deluxe and Publishing Suite include PhotoEnhancer, the easy way to manipulate and edit your photos. In PhotoEnhancer, itÕs a breeze to get rid of red eye, increase sharpness, adjust the brightness of your photos and change colors and textures of your graphic images.
	Make sure the image you want to work on is active (the handles are showing around it).
	1. Click on the PhotoEnhancer button on the Modify toolbar. The PhotoEnhancer application will open with your image in its window.
	
	Note: PhotoEnhancer works only on bitmap graphic files (like BMP, GIF, JPEG, TIFF, etc.).
	2. There are two easy ways to adjust your scanned image in PhotoEnhancer, using the Enhance and SmartPix menus.
	¥ The Enhance menu allows you to Adjust, Soften, Sharpen, Intensify, and Lighten Shadows in your image.
	¥ The SmartPix menu helps fix snapshots that were taken in bad light. Use the selections in this menu to correct pictures by the lighting condition in which they were originally taken. For example, select the Daylight (Bright) command to correct pictures taken in bright sunlight where shadows may have been washed out.
	3. If you want to make changes to only a portion of your scanned image, select that portion with one of the three selection tools.
	4. Once you have selected the area of the image you want to work on, try different menu selections in the Enhance or SmartPix menu until you get the effect you want. Remember, you can undo any change by selecting Undo in the Edit menu, or press Ctrl-Z.
	For Red-Eye Reduction:
	1. You can reduce red-eye in your snapshots by clicking on the Red Eye tool in the PhotoEnhancer tool palette. Your cursor will take the shape of a paint brush.
	2. Zoom into the image, if necessary.
	3. Paint over the red in your subjectÕs eye.
	4. When finished, zoom out and your picture will contain no more red eye.
	5. After you have made adjustments to your image in PhotoEnhancer, click on Save under the File Menu of PhotoEnhancer, then Quit. You will then be returned to PrintMaster GoldÕs Workspace, where your adjusted image will be placed on your project.
	Note: For more help on using PhotoEnhancer, see Working with PhotoEnhancer below, or click on the Help menu within PhotoEnhancer.
	Place your image behind the Photo Effect template


	Objects on your project are layered in the order in which they are placed on the project. The first object placed on your project will be on the bottom, and every object placed after it will be stacked above it.
	To get your image to show through the Fun Photo opening, youÕll need to first place it behind the Fun Photo.
	1. Click once on your image so it is the ÔactiveÕ object in your project (the handles are showing around it).
	2. Move your image so the face is approximately over the opening in the Fun Photo.
	3. While your image is still active, click the Backward One button on the Place menu. Your image should appear behind the Fun Photo. If it does not, click the Backward One button again until your image is one level behind the Fun Photo.
	Tip: Press the Tab key several times to view the different layers of objects on your project.
	4. Click inside the face opening of the Fun Photo. Now you can move the image to align it with the opening on the Fun Photo, without bringing it forward.
	Resize an image


	You may find the face on your image is too big or too small to fit properly in the Fun Photo opening. The following steps will help you resize your image so your Photo Project will appear more realistic.
	1. Make sure your image is ÔactiveÕ (handles showing around its edges). If it is not, click inside the opening of the Fun Photo, directly on your image, to make it active. If you are having trouble selecting your image, hit the Tab key to cycle through the different levels of objects in your project until your image is active.
	2. Once your image is active, place the cursor on the handle (the small square box) on the bottom right corner of the image. You can now drag the mouse diagonally out and down to make the image larger. To make sure the image keeps its exact proportions, hold down the Control (Ctrl) key while dragging.
	Crop a photo image


	Your scanned image may be too large or include things youÕd like to crop out. PrintMaster Gold has a cropping tool that allows you to see only the portion of the photo you want to see, without removing or disturbing any part of the image.
	To crop your image:
	1. Make sure the image you want to crop is active (handles are showing around its edges).
	2. Click the Crop tool on the Modify toolbar.
	3. Place the cursor over any handle of the image. The cursor will turn into a cropping tool. You can now drag the handle to create a new window through which you will view your image.
	Note: You are not altering the image, you are just reducing or enlarging the ÔwindowÕ through which you can see that image.
	4. With your image still active and the cropping tool button selected, place the cursor over the center of the image image. The cursor will turn into a ÔmoveÕ hand. By clicking and dragging your image, you can move the image within the cropped window to see only the portion of the image you want.
	Tip: When you click on an object, make sure you click on an opaque part of each object. If you click on a clear or transparent part of an image, you will most likely select the object underneath it.
	Save your Photo Project


	LetÕs save your Photo Project with a unique name and attributes so you can easily find it in the future.
	1. Click the Save button on the Global toolbar. To save an existing Photo Effect project under a new name and description, select Save As... from the File menu. PrintMaster Gold will then prompt you to type in a new file name and description.
	2. Type in the new File Name into the box provided.
	3. You may also attach a short description to your Photo Effect project by typing it into the Description box. Or, you can add new words to the keyword list so you can more easily search for it in the Ready Made Gallery.
	4. To change the default drive and/or directory that your project will be saved to click Change... and select the new destination.
	5. Click OK or press ENTER to save your Photo Effect project project.
	Tip: If you would like to print your Photo Project on to an iron-on transfer, first select all the items on your project (Ctrl-A), Group them (click Group button), then click the Mirror button so all of the objects are flipped. Now, when you iron the images on to a T-shirt, they will appear correctly.

	Design Tips from the Pros
	ÒIÕve found the best way to make a Photo Project is to first look for a snapshot of one of my friends that is bright and clear. Then I scan the photo at a high a resolution as I can--usually around 600 to 700 dpi works best--so I can make the image larger in PrintMaster Gold without distorting it or making it look jagged.Ó Ben Atley - Designer


	Newsletter Tutorial
	PrintMasterÕs Newsletter Ready Mades can help you create sharp, colorful newsletters fast. Our Ready Made templates include all the pieces you need: headlines, columns, connected text boxes, and graphics. Plus, PrintMasterÕs newsletter project can be used to create bulletins, newspapers, reports, and other multi-page documents.
	Open a Ready Made Newsletter template

	The PrintMaster Gold Ready Made Gallery provides many different categories of Newsletters from which you may choose.
	1. From the Hub screen, click Ready Made. If you are in the Workspace, click the Ready Made button on the Global button bar. You will be taken to the Ready Made Gallery. To narrow your search for an appropriate newsletter design, choose a Category, Tone, and Style.
	A larger display of a newsletter can be viewed by clicking the View menu at the bottom of the Ready Made Gallery window and selecting the Large option. You can then scroll through the pages of the newsletter template by clicking on the Page View pop-up menu. To return to the standard preview open the View menu again and select View Medium.
	2. Once you find the newsletter design you want in the Ready Made Gallery, click on it, then click Select (or double-click your selection). The newsletter you selected will then be placed in the Workspace, ready for you to replace the sample text and graphics.
	Tip: Prioritize information in newsletters and brochures. Establish areas with current news ÔbitesÕ to hilite events or set off helpful tips. Breaking up longer, in-depth stories with shorter, fast-paced ones establishes a good information flow and helps keep the readerÕs interest. Pete Russitano - PrintMaster designer
	To create a new Newsletter:

	1. Click the Brand New button in the Hub.
	2. When creating a new newsletter, you will be prompted to select a page layout for your new project. Use your mouse to select the Newsletter Size.
	¥ The Size option Tall (or Portrait) prints text across the short width of the paper.
	¥ The Size option Wide (or Landscape) prints text across the long width of the paper.
	3. Once you have selected the newsletter size, click Finish. Your blank newsletter will be placed in the Workspace, ready for you to enter your own text and graphics.
	Connecting Text Boxes


	When typing long passages into a text box, the text may run longer than fits in the box you have created. The extra text isnÕt lost, you just canÕt see it within the frame of the text box. When your text overflows the text box, you can connect to another empty text box anywhere in your newsletter, so the text will flow from one box to the other.
	1. Click the Link icon at the bottom of your first text box. You will notice if you then move the cursor over the text, it will become a Text Pour icon. You can now pour the overflow text into any other empty text box.
	2. Click into an empty text box where you want the overflow text to go.
	
	Note: You cannot connect two text boxes with the Text Pour icon if the destination text box has text in it.

	Viewing All Connected Text Boxes: You can view all connected text boxes by clicking on the Previous or Next Text Box arrows at the top and bottom of each active text box. Click the right arrow (New Text Box) to view the text box that contains the overflow from that box. Click the left arrow (Previous Text Box) to view the text that comes before the text in that box.
	Tip: Small, neatly placed icons or pictograms, when used with a primary design element (like color boxe) can help illustrate difficult concepts, such as travel, time, technology, and emotions. Pete Russitano - PrintMaster designer
	Disconnecting Text Boxes

	1. Click on the first text box you would like to disconnect. The text box will display a Next Text Box button (right arrow), showing that it is connected to another text box.
	2. Click on the Link button. The cursor will again turn into the Text Pour icon.
	3. You can then either:
	¥ Click inside the text box, disconnecting that text box from all following boxes. The text will now stay within that text box, or
	¥ Click into another empty text box, connecting the text to the new text box.
	Inserting Additional Pages


	One of the unique features of a Newsletter project is the ability to work with multiple pages. To insert additional pages to your Newsletter proceed as follows:
	1. Pull down the Add menu with your mouse and select Pages (or press ALT+A+A on your keyboard).
	2. In the dialog displayed, type in the number of pages to add.
	WhereÑUse this option to determine the placement of additional pages. Choose either:
	¥ Before Current Page
	¥ After Current Page
	ContentsÑUse this option to add the type of pages to your Newsletter. Choose either:
	¥ Add Blank Pages
	¥ Add Copies of PageÑUse this option to duplicate existing pages by typing in the page number of section to duplicate.
	3. Press ENTER or click OK to add your new pages.
	Hint: To add pages quickly, click on the right arrow of the View Page window (at the bottom of the screen) while viewing the last page of your newsletter. This will bring up the Add Page dialog box, where you can add a page or pages to your project.
	Save Newsletter


	This command will enable you to save your Newsletter project with a unique name and description that you provide.
	1. Click the Save button located on the Global toolbar. To save an existing Newsletter project under a new name and description, select Save As... from the File menu. PrintMaster Gold will then prompt you to type in a new file name and description.
	2. If you are saving a new Newsletter project, PrintMaster Gold will prompt you for a unique file name. Type in the new File Name into the box provided.
	3. You may also attach a short description to your Newsletter project by typing it into the Description box. You may also enter keywords so you can search for your newsletter in the Project Gallery.
	4. To change the default drive and/or directory that your project will be saved to click Change... and select the new destination.
	5. Click OK or press ENTER to save your Newsletter project.
	Print Newsletter


	This option brings up the Print dialog enabling you to print your Newsletter project. From this dialog you can also choose the number of printed copies, the print quality, and other features.
	1. Click the Print Newsletter button to display the Print dialog box.
	2. Click Print to begin printing your project.
	Print RangeÑUse this option to select what pages of your multi-page document to print.
	Double-Sided Printing Wizard


	PrintMaster Gold includes an easy-to-use Double-Sided Wizard to help you determine the best way to print your double-sided print projects.
	The Double-Sided Print Wizard takes you step-by-step through a sample printing project, and according to your responses, configures PrintMaster to print double-sided projects automatically in the future.
	1. Once your double-sided project is completed, select the Print button on the Global menu or type Ctrl+P.
	2. Make sure Double-sided is checked on the Print dialog box.
	3. Click Print. The first time you print a double-sided project, you will see the Double-Sided Wizard. If you have not yet set your double-sided print configuration and the Wizard does not appear, select Double-Sided Print Setup... under the File menu.
	2. The Double-Sided Print Wizard will first ask you to print a 2-page test project. After the two pages are printed, follow the directions on the Wizard screen. You will be asked to match the printed pages to icons on the Wizard screen, place the pages back in the printer, print again, then select the configuration that matches the final print out order.
	3. Once you have answered the questions on the Wizard screen, click Finish. PrintMaster Gold will now be configured for subsequent double-sided printing. You can now print multiple-page, double-sided projects such as newsletters, cards, and envelopes.


	Address Book and Label Tutorial
	PrintMaster GoldÕs Address book is an easy way to keep track of names, addresses, and birth dates, then merge that information into all types of projects. The Address Book, used with Fill-in Fields, can print dozens of personalized holiday cards for all your relatives, invitations for your friends, labels for your customers, or certificates for your students.
	In this tutorial, you will learn how to create an Address Book, then youÕll use the Address Book entries to create your own custom labels.
	Creating a new Address Book

	The Address Book is a good way to electronically keep track of names, addresses, birth days, and other information. The best thing about PrintMaster GoldÕs Address Book is that itÕs an easy and powerful way to merge the names and addresses of your friends, family, or other acquaintances into any PrintMaster Gold printing project!
	The following instructions describe how to create a new Address Book.
	1. From anywhere inPrintMaster Gold, pull down the Tools menu with your mouse and click on Address Book, or press ALT+T, A on your keyboard.
	If you have not already created an Address Book, PrintMaster Gold will start you off with a blank address book called: Address. You can edit this address book or click New under the Address Book File menu and create your own using a different name.
	2. Use the displayed fields to begin entering the basic information for each person youÕre adding to your Address Book. You can fill in any fields you want, but it is best to include at least the First Name and Last Name. The available fields are:
	3. Click the New button to begin working on a new record for your Address Book. Use Tab and Shift+Tab to navigate to the next field or backup to a prior field.
	4. Click the Save button to add a completed record or save changes to an existing. To remove an entry click Delete button. To reverse changes made to a record click the Undo button.
	Creating a new label


	Now that you have some information in your Address Book, letÕs create a label and have PrintMaster Gold automatically insert your Address Book information into each label.
	PrintMaster Gold makes it easy to create dozens of different types of labels for envelopes, floppy disks, video cassettes, name tags, and many more.
	To create a new label:
	1. From the Hub screen, click Brand New. Then, in the New Project dialog box, choose Label.
	2. You will be prompted to choose a Label Type.
	¥ Select Laser Labels if you will be printing your labels on a laserjet, inkjet, or bubblejet printer.
	¥ Select Dot Matrix Labels if you will be printing your labels on a dot matrix printer.
	3. From the provided list, pick the specific type of labels to be used. Click OK to begin editing your Brand New label in the Workspace.
	Open an existing Label

	1. From the Hub screen, click Ready Made, then, under Project Type, choose PrintMaster/Label.
	2. Browse through the Ready Made labels to find one you like. To narrow your search, select a Category and Style. Remember, you can make as many adjustments as you like to the Ready Made label once you enter the Workspace.
	3. Once you have found a Ready Made label you like, click once on the label, then click Select (or, double-click the label preview). You will then be taken to the Workspace where you can work on your Ready Made label.
	Note: The Ready Made label you chose in the Ready Made Gallery may not represent the label type you desire. To change the label type, click Edit in the menu bar, and click Choose Label Type (or, press Alt-E, Y). Then choose the label type you desire from the list presented. You may have to make adjustments to text size and graphic placement if the new label size is considerably different from the original.
	Adding Fill-in Fields to your label project


	Fill-in fields are placeholders that can be Òfilled-inÓ with personal information from your Address Book or with any information you type-in. To add a fill-in field to your label project, proceed as follows:
	1. Begin by adding a text box to your label project. If you are working with a Ready Made project, delete the sample text in the text box, but leave the empty box.
	2. Make sure the empty text box is active (the handles are showing around it), and the insertion point (the blinking cursor) is placed inside the text box.
	3. Under the Add menu, select Fill-in Field. A list of available fill-in fields will be displayed at this point. Use the scroll bar to the right to move up or down the list of fields.
	Tip: To quickly add Fill-In Fields, right click on the active text box and select Add Fill-in Field...
	4. Pick a fill-in field by clicking on its name.
	5. Click the Insert button to add the selected field to your project page.
	Or, to more easily insert standard information:
	¥ Click the Receiver Address button to automatically insert Receiver First Name, Last Name, Title, Company, Address1, Address2, City, State, and Zip fields. This is often the best selection when you are sending out lots of mailers, envelopes, or invitations with a different name and address on each item.
	¥ Click the Sender Address button to automatically insert the Sender First Name, Last Name, Title, Company, Address1, Address2, City, State, and Zip fields. This will create a series of labels with your name and address on each. This is best when you want to create many identical return address labels, cassette labels, books plates, or business cards.
	6. To insert additional fields, repeat steps 4 and 5.
	Note: Fill-in Fields do not have to be inserted into an empty text box. They can also be added to text boxes that already contain existing text. Fill-in fields are inserted at the text cursor position.
	Applying Values to Fill-in Fields


	Once you have placed fill-in fields onto your project page you will need to assign values to each of the inserted fields.
	1. To begin, select Fill-in Fields in the Edit menu.
	A list of the field names used in your project will appear on the left side of the dialog box. To the right a space will be provided for typing in values for each of the fill-in fields.
	You may enter your own values for each field, or you can select values from the Address Book so your Address Book information will be merged automatically.
	2. To edit a field, simply click on the field with your mouse and begin typing in the desired data.
	¥ Use Tab and Shift+Tab to move to the next field or to backup to a prior field.
	3. To automatically merge information from the Receivers List of your Address Book, click the Receivers... button.
	4. Pick the receiver name(s) you wish to use by clicking on them with your mouse. Once you have chosen the desired name(s), click OK.
	¥ Or, click All to have all the names in your Address Book merged into your project.
	Note: When selecting multiple receiver names, only one of the chosen names will be displayed on the project page (generally the first one selected). You will also only see one name listed in Print Preview. However, upon printing your project each printed page will contain a different receiver name.
	5. Click OK to return to your project page.
	Note that the fill-in fields seen earlier have been replace by the first name in the receiver list you selected. At this point you can now begin editing your text by changing items like font, color, size etc.
	Print Label

	This option brings up the Print dialog enabling you to print your Label project. From this dialog you can also choose the number of printed copies, the print quality, and other features.
	1. Click the Print button on the Global toolbar or hit Alt+F, P on your keyboard to display the Print dialog box.
	The following buttons are available on the Print dialog box:
	The Fill-in Fields...

	This button allows you to make changes to the number of names that will be printed. To the right of the Fill-in Fields button is an indication of how many Fill-in fields PrintMaster Gold has retreived from your Address book. To change that number, click the Fill-in Fields... button and re-select names from your Address Book.
	Number of Labels:

	This button allows you to choose how many of each name merged from your Address Book to print out. For example, if you are merging three names from your Address Book, you can choose to print each name twice by typing Ò2Ó in the Number of Labels box.
	Starting Label...

	Use this item to specify the starting label on any printout. This feature is useful when printing to a page containing only a partial number of labels. On printouts consisting of multiple pages, this feature will only apply to the first page. Any additional pages will start printing on the first label.
	2. Click Print to begin printing your project.

	Design Tips from the Pros

	Calendar Tutorial
	With PrintMaster Gold you can design a Calendar to fit in your wallet or fill a bulletin board. Monthly, weekly, and generic calendar styles are available and any day can be enhanced with both text and pictures.
	The following instructions describe how to
	¥ Create a new Calendar project
	¥ Open an existing Calendar project
	¥ Add text to a date
	¥ Add pictures to a date
	¥ Copy Date information
	¥ Review the Calendar menu options
	¥ Save a Calendar project
	¥ Print a Calendar project.
	Beginning a Calendar

	1. In the Hub screen, click Brand New, select a Calendar project, and then click Next.
	2. When creating a new Calendar, you will be prompted to select a page layout for your new project. First, use your mouse to select the Calendar Size.
	¥ The Size option Tall (or Portrait) prints text across the short width of the paper.
	¥ The Size option Wide (or Landscape) prints text across the long width of the paper.
	3. Next, choose the desired type. PrintMaster Gold supports three Calendar Types.
	¥ Monthly Calendars show a full month of dates.
	¥ Weekly Calendars show a single week of dates.
	¥ Generic Calendars are weekly Calendars without any specific date numbers.
	4. Select the Calendar date (Month and Year. Also choose the Week for Weekly Calendars). Click the Now button to select todayÕs date. PrintMaster Gold will automatically label each day of Monthly and Weekly Calendars with the proper numbers based on the selected date.
	5. Click Finish or press ENTER to begin editing your Calendar project.
	To open an Ready Made Calendar:

	1. From the Hub screen, click Ready Made.
	2. In the Ready Made Gallery, choose PrintMaster/Calendar. Under Category, you can choose either Monthly calendars or Weekly calendars. If you would like to narrow your search, choose the Tone or Style of the calendar you are looking for.
	2. Highlight a Calendar project by clicking on its preview. To see other Calendar projects within the same category, scroll down the Ready Made Gallery preview screen.
	3. Once you have found a calendar you are interested in, click the preview once, then click Select. Or, double-click the preview. You will then be taken to the Workspace.
	Adding Text to a Date


	Text can be added to a particular date by simply double-clicking on the date box with your mouse.
	Note: You may want to zoom in on the date you wish to add text to.
	Adding a Picture to a Date

	You can attach any picture to a date box.
	1. Right-click the mouse button over any date of your Calendar project.
	2. On the popup dialog, select Choose Date Picture... You will be taken to the Art Gallery, where you can choose your picture.
	Note: Only a single picture is allowed per date and the picture is always sized to fit the box.
	Tip: Repeating elements on a page can create an exciting atmosphere. Change the size, color, tint, placement, and layer position of each repeated element to keep it interesting. This works great with snowflakes, balloons, flowers, Holiday ornaments,and even text. Pete Russitano - PrintMaster designer
	Change Picture Color


	To change the color shading of a picture attached to a date box, right click on the date box to bring up options to change Picture Color or Picture Attributes.
	Copy Date Information

	To copy the contents of one date box to another, click on the date box you want to copy and while holding down the left mouse button, drag the date box to the new destination. When you release the mouse button, the text and pictures will be copied.
	Changing Calendar Information

	Additional features for editing your calendars are available on the Calendar menu located at the top of the project screen. Open this menu by click on its name or by pressing ALT+C.
	Month and Year...

	Use this option to change the Month and Year of your Calendar project. For Weekly Calendar projects your can use this option to change the week. PrintMaster Gold will automatically number the days for the date your choose.
	Calendar Style...

	Use these options to customize the look of your Calendar project. Click the Default button to reset all items to their original values.
	Weekday Names
	Use this option to edit the style of weekday names. Three variations of weekday names are offered:
	¥ Text Only displays only the weekday names.
	¥ Boxed Text displays the weekday names in boxes.
	¥ Reversed Text displays the weekday names on a black background.
	Weekday Spelling
	Use this option to specify the spelling of the weekday names. Three variations are supported:
	¥ Initials displays the weekday names as S, M, T, W, T, F, S.
	¥ Abbreviations displays the names as Sun, Mon, Tue, Wed, Thu, Fri, Sat.
	¥ Full Names displays the weekday names as Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday.
	Lines
	This option controls what lines are drawn around the Calendar date boxes. Lines does not effect any box drawn around weekday names.
	¥ None displays no Calendar lines.
	¥ Horizontal displays only horizontal lines.
	¥ All Lines displays all Calendar lines.
	Line Color
	Click this button to choose the color for the lines drawn around the Calendar date boxes, the box drawn around the weekday names, and a color shadow.
	Shadow
	This option is used to add a shadow effect to your Calendar.
	¥ No Shadow turns off any shadow effect.
	¥ Black adds a black shadow to the Calendar.
	¥ Gray adds a gray shadow to your Calendar.
	¥ Light Gray adds a light gray shadow to your Calendar.
	¥ 100%, 50%, 25% Color adds a shadow of the chosen Line Color (see above) to your Calendar. The color is rendered at the selected percentage.
	Outline
	Select this option to add an outline around the entire calendar.
	Edit Calendar Title Text

	Use this option to edit the contents and style of the Calendar title. You can also edit the title by clicking on the project layout area with your mouse.
	Date Number Font...

	This option enables you to change the font style of the date numbers on your calendar.
	Weekday Name Font...

	Use this option to change the font style of the weekday names (Mon., Tues. Wed., etc.).
	Edit Date Text

	This option enables you to edit the text inside of a date box.
	Choose Date Picture...

	This option enables you to attach a picture to a date box. Only a single picture is allowed per date and the picture is always sized to fit the box.
	Date Picture Color...

	This features enables you to change the color shading of a picture attached to a date box.
	Date Picture Attributes...

	This option enables you to adjust attributes (color, render method, etc.) of the selected picture. (See the chapter entitled: Working with Pictures later on in this guide for more detail.)
	Clear Date

	Use this option to remove text and picture elements only from the currently selected date. Other dates will remain unchanged.
	Design Tips from the Pros
	Soft, mutued colors are an important way to achieve subtle feelings in a design. They can soothe, warm, soften, add elegance and emotion, and are a welcome departure from the bright, jarring images of the day. Pete Russitano - PrintMaster designer
	User Tip:
	I once used the calendar project for my girlfriendÕs birthday, and it worked out great. Every day for two weeks, I printed out the same calendar with a new greeting at the bottom and another day crossed off. Then, every day I sent it to her. On the last day, I brought the last calendar to her office with roses. I think she liked the anticipation of the event as much as its arrival. Bob Alewon - PrintMaster user



